BEST PRACTICES COURSE – WEEK 17 – Complex Modeling PART 7Roofmaker
Welcome everyone to the ArchiCAD Best Practices course training lesson. This lesson will be focused on
Roofmaker. We'll start out by simply drawing a box of walls here and placing a roof on it. And while we
can do all whole variety of complex roofs, we'll start out with something simple and see how Roofmaker
works. With the default template, I will need to set the roof up at 10 feet here to fit on top of the walls.
[0:00:38]
Now Roofmaker is a tool that you'll find under the Design menu, and it is under Roof Extras. You will
see 'Roofmaker'. Now in versions of ArchiCAD going back a little bit, Roofmaker was something that you
might have to install as an extra. It would have been available under the Help menu under ArchiCAD
Downloads or ArchiCAD Goodies. So you might have to go, if you are on ArchiCAD 12 or 14 or
something like that, you might have to go to one of those commands. And then on the Graphisoft
website, download that goodie as an extension to ArchiCAD, install it, and restart ArchiCAD. It will show
up under the Design menu. [0:01:24]
Now in versions of ArchiCAD starting with 15, there is a Roof Extras menu, and you can see it says, 'Crop
to single plane roof', 'Crop zone', 'Create roof levels with lines'. Some of these may not exist in earlier
versions of ArchiCAD, but Roofmaker certainly has been around back to version 10 or earlier. Now what
Roofmaker does is it creates framing, stick framing we can call it. Rafters, blocking, beams, collar beams,
tie beams etc. It also has the ability to create an entire roof system. Now what it's doing is it's creating
one or more elements that are GDL objects. So they're basically like using the object tool, except that
they were placed based on the roof geometry. [0:02:15]
So it's creating rafters based on the shape and position of the roof. Once it creates one or more of these
things, they are independent of the roof. So you can actually move them around. They are separate
objects, but the convenience is that it will build them up based on rules, the sizes of the members you
want, the spacing, things like that; using the roof geometry. So you generally want to create a roof first
and then build the Roofmaker elements from that. So in fact, if you try to create any of these elements
without a roof, it will refuse, it just won't work. Now there is a tool box here. You can see 'Show
Roofmaker toolbox'. [0:03:00]
When I bring that up, it opens up a tiny window here. Each one of these commands, if I hover over it, it
says, 'Create a rafter', or 'Create multiple rafters'. Those are exactly the same commands as you will find
under the Design menu, Roof Extras, Roofmaker. And you can see here are the same icons that are in
that palette over there. So this is just a convenience once you are familiar with it. Now I'm going to go
back and forth between using the menu and using that toolbox. I'm going to be demonstrating some
things. I am not an expert on roof design. As I think most of you know, although I speak architecture
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language pretty well, I'm not an architect. I don't design buildings, so there are some things that I know
only when people ask me, "How do I do this?" And I then get clear on it. [0:03:55]
So I'm going to demonstrate some things, I will probably make a few mistakes in terminology or just be a
little naive, but the technology I can explain. And that's what we are going to focus on. And then I will
open it up for questions so you can ask me for clarification on things that maybe I don't explain well
enough or maybe I made a mistake on. So in terms of understanding Roofmaker, I am going to be
demonstrating that, but if you want a reference, the best place to go is under the Help menu where
you'll find the ArchiCAD reference guide. In this case, it's the ArchiCAD 17 reference guide. And the
reference guide comes up as a PDF file in your favorite PDF viewer such as Acrobat reader. [0:04:38]
In this guide you can generally use a search function to say, "I'd like to find something about
Roofmaker." And it will find the Roofmaker reference in the table of contents. Now that it has found
that, if I click on this, it will take me to that page in the reference manual. If I make it a little wider,
we're going to see it clear enough onscreen that you'll be able to at least get the basics here. So we're
going to be looking at the Roofmaker pieces and then we're going to be looking at the roof wizard. The
roof wizard, if I go here, is something that will build a whole set of roof elements automatically. So we're
going to look at first the little pieces and then we'll go back to the individual ones. [0:05:34]
So if I go back into here, you can see all of these components in this view. Each one of them would be a
separate object. And it gives some basic explanation, including the fact that they recommend that you
set the reference line of the roof to the upper exterior edge of the wall beneath. So while you can
create roof elements in a variety of ways, the simplest way that will work the most elegantly with
Roofmaker is that the reference line of the roof is the exterior edge of the wall beneath. And it's going
to use that as the geometry for placement of these roof framing elements. It also recommends that you
set the roof thickness equal to the general cross section height of the rafters. [0:06:26]
What that means is that initially you'll want to set the roof thickness to the rafter size, not the size that
includes shingles, plywood shingles or tiles on top. Later you can go and change the roof thickness to
include those extra elements, or you might prefer to draw a separate roof on top of the original one that
is intended to represent the cladding and the tiles and things like that. So those are two key things to
remember. If I go into ArchiCAD and look in 3D, of course we just have this basic roof shape on top of
the walls. I'm going to select the roof and say, "What layer is it on?" It's on A-Roof Layer, so no big
surprise there. I'm going to go into the layer dialog by hitting Command+L or Ctrl+L, and I'm going to
turn this roof layer into a wire frame. [0:07:25]
That will allow me to see through the roof elements. So now we're seeing the outline of the roof. This
is not something necessary, but it's definitely good for visualizing what we're doing in the 3D view
because actually these elements will be buried inside of the roof. So let's look at the first step that we
can do. If I select this roof and go to the Design menu, Roof Extras, there's the option under Roofmaker
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to create a rafter. And again, we can use the palette to decide there once we've opened up the
Roofmaker toolbox. Regardless of how you do it, if I say 'Create a rafter', it will tell me that I need to
select a single component of the multi-plane roof. If you're working with roofs before ArchiCAD 15, then
this roof system would've been a set of four separate roof elements. In ArchiCAD 15, we introduced the
multi-plane roof. [0:08:27]
This is a single element with four planes. And while Roofmaker will work with these four planes or with
the entire system, it says, 'If you want to place a rafter, tell me which one of these pieces we want first.'
So to place this element, one single plane roof needs to be selected first. This is a little confusing
because it's not a single plane roof, it's one single plane of the multi-plane roof that needs to be selected
first. When I demonstrate this, it will be clearer. I am going to click OK, and notice in the prompt box
down at the bottom of the screen it says, 'Click a roof'. I will click somewhere in the middle, and now
having done that, it says 'Rafter settings'. Remember I clicked on the button that says, 'Create a rafter'.
[0:09:16]
So rafters, just like all of the other framing elements in Roofmaker, have dimensions of width and
height, and we can modify those as needed. I'm not going to bother, because I don't know what would
be the appropriate size. Just know that you can set them to whatever size you need, and the spacing,
for example at top, the hip rafter here, this is going to determine how close this rafter goes to the end.
So in other words, the rafter is going to go up to the top but it's going to leave space for that. So this
certainly is something that you'd want to define. And of course you'd want to define all these things.
You have options for how the rafter angle at the top and the eaves angle, these are handled. So you
have some flexibility here. And the width of the valley rafter. [0:10:10]
So all of these things can be compensated for or incorporated into setting. You have some options for
what it's going to look like on the floor plan, either as an outline with an axis or without an outline, just
simply a line indicating the axis. Now we're not doing multiple rafters, that's why this is gray; we're
doing a single rafter. Each of these elements has a material. In ArchiCAD 17, we have a surface. So this
little paintbrush indicates a surface. Before ArchiCAD 17, that would've been called the 'surface
material'. Now we reserve the use of the term 'material' to building materials, which have a different
meaning in 17. But essentially this paintbrush will be the same in earlier versions as it is now. [0:10:59]
And these elements have a layer that they're going to be on. Instead of putting them on the roof layer,
which is going to be wire frame, let's put them on a different layer. Now I'm going to put them into a
beam here. So they're not technically a beam, but I'm going to be putting it on a different layer than the
roof layer so that it's not a wire frame. So these can be put on any layer and I'll say OK. Now having just
verified the dimensions of it, it's now saying 'Enter position inside the roof or on the edge of the roof'.
So I'm going to click on the edge of this roof, and we'll see how instantly it has put in this element. If I
zoom in on it, we'll see that this element has a solid outlined body and an axis line. [0:11:55]
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Let's take a look in 3D, and we'll see there, okay, it's come in. And it looks like a rafter. The gap here
remember is based on what it expects the ridge line element to be. With this element, if I select it, you
can see it is an object. It's an object that I can select. I could go in and modify it, so there are various
settings that we can change here including possibly changing it to a different type of framing element,
different dimensions. So all of these things are editable after the fact, including the extension here.
[0:12:39]
So this is an extension that says it's 2 feet beyond the wall. So this two foot distance here is based on the
fact that this original roof was set up with an overhang of 2 feet. So if we had a roof that its overhang
was 1 foot or 300 mm or something like that, then it would use that as the basis. So it took the
information from the roof to do that. And of course it fit in nicely to the slope, whatever the slope of the
roof is. Now let's look at the next command that we might do, the next thing I want to teach you. The
next thing down on this list here is create multiple rafters. So let's click on that. Again it will say, 'Which
one of the single roofs do you want to work on?' [0:13:30]
Remember, the roof wizard will create a whole system, but I want to teach you the basics of the
individual pieces first, and then we will look at how a roof system is built up essentially from doing all of
these at once. I will say OK. It says 'Which one?' I will click on the left side here. And now it says the
same information. Whatever I've set up it's going to remember. I'm going to put it on the A-Beam layer,
so it remembers that was the last one I did. Now it says, 'How are the distances being set up?' I said I
want them to be every 2 feet or something. I type that in. It will have a fixed distance, but it also has
options for how it's going to be assuming the distance we specify is not an even multiple of the distance
here, how is the gap going to be handled. [0:14:18]
If I want to say I'd like to put in a certain number between two points, it will evenly divide that. This is
similar to the multiply command, except that the gap is an option here. You can say that you want to
change, when it's not an even number, how that's going to be. It says there's going to be a maximum
distance between the rafters. I will say OK, and having done that it says, 'Enter the beginning of the
rafter range inside the roof'. Remember I clicked on his left-hand roof here. I'm going to arbitrarily click
two points. And you'll notice when I click these two points here that it created a number of these
rafters between those two points perpendicular to the roof. [0:15:06]
So it's smart enough to basically make sure that my first click and second click point are going
perpendicular, and it's spacing them the maximum distance that I specified in between. Now if we look
in 3D we will see what these elements are doing here. Now if I go and select the roof again and we look
at this, this is 'Create a hip or valley rafter'. That would be the rafter between two roof planes. If I click
on that, it says, 'Please click on one of the components of the selected multi-plane roof.' So I'm going to
click this one. Now this is going to be the hip or valley either on one side or the other. And these are the
dimensions. [0:16:00]
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Now this one apparently didn't pick up the layer there. If I'm doing these individually, I may have to set
the layer and the next time I do a hip or valley it will remember that. But there are all of these different
controls. And say OK click on this edge here. By the way there's a little prompt saying, 'Click on an edge.'
So we can do them one at a time if I did it again. Let's click on this, click here, click here, and you can see
how I can go around piece by piece and each one of these elements has controls. So I could modify it
after the fact. I think you get the idea of that. [0:16:40]
Now the roof is selected and there's an option here for 'Create blocking'. Now when we want to create
blocking it will say you have to select two rafters first, because the blocking goes between two adjacent
parallel rafters. So while I could have the roof selected, it's essential that I have two rafters selected.
Now you'll notice that when I selected one of these rafters it selected all of them, because they were
grouped. When you put in a bunch of elements at the same time, they group automatically. Under the
Edit menu, Grouping, Autogroup is not turned on, but with Roofmaker it automatically makes all of
these a group. That does allow you to select them quickly and maybe change all of them in terms of the
dimension or their other settings. [0:17:30]
Let's just see if we can do the blocking here. So it says blocking is okay, we can do this. It says, 'How do
you want this handled? Perpendicular or vertical blocking between them, what dimensions?' Here's a
little preview of that. The preview didn't change from the picture. Let's again put this on the beam here
and say OK. And now it says, 'Enter position of blocking between the rafters.' So let me just click here. It
says, 'Blocking cannot be created there.' So let me try again and click on this. 'Blocking cannot be
created here.' So let's just see then if I go and suspend groups and select two rafters, then blocking here,
and click, now you see how it put that in. So I'm not sure if you select multiple ones beyond that if it will
work. I think the idea is that you would pick two and then specify where you want that to be. [0:18:37]
So I pick any two here and just go create the blocking. I wonder if I can snap to this point here to line it
up. No, I cannot do that. So I need to actually click on this point. I can line this up. I could use a guideline
or create a line if I wanted to be specific there. So that's blocking. Now the next one down would be
'Create a beam'. So if I select the roof and I say 'Create a beam' here - let's make sure that we have the
right one, move away from it. Let's get the prompt. This one is 'Create blocking'. This one is 'Create a
beam'. It says, 'Please click one of the components of the selected multi-plane roof.' So basically which
plane do we want to put a beam on? I will say OK, click on this roof. Notice the little prompt says 'Click a
roof'. [0:19:40]
And it shows some dimensions. Again, we may need to put the layer there and say OK. I will click here
and you can see how it puts it through. The rafters go perpendicular to the roof reference line. The
beam goes parallel to it. It's smart enough to know that. It's also going to put it in at the right geometry.
This is now underneath that element, it is supporting it or it's in a position where it would support that.
You can see how it's picking up that geometry from the roof and allowing you to build this piece by
piece. Now the Roofmaker toolbox will only show in the floor plan. We're looking at it in 3D, we can see
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these and we could select these elements and change some settings in the 3D. We can go into beam
settings and modify stuff. But we can only use Roofmaker on the floor plan with this palette there.
[0:20:52]
Here's 'Create a beam'. 'Create a plate beam'. So if I select this and we go in here, and it says, 'Enter the
position inside the roof or on the edge of roof.' Now I just clicked on a point arbitrarily in space. Now it
has 'Enter the side of the beam to be placed on.' I'll click this way. So it does have an orientation here. I'll
go to 3D. So I'm just placing these at random just to give you a quick idea. When we create the roof
system, we're going see how it automatically puts them all fitting into each other. Now if I were to do
the next one, which is a collar beam, or the one after that which is a tie beam, they need to have the
rafters facing each other. They are basically going to join two rafters on opposite sides. [0:22:02]
I'll go in and select this roof, go and create a rafter here. I will click on this roof here and then I'm going
to just click to place this. These are not in line, but just to demonstrate, I can go grab this and drag it
over in line. Now having dragged it over in line, if I select these two rafters, then I can do the collar
beam. There are things that we can specify: what height we want these to be going across, all of its
dimensions here, single sided or double sided. Say OK and you can see how it's put the collar beam
across there. If we look in 3D, we are going to see what it created. Now it looks like I didn't change the
layer, so that's why it's wire frame. [0:22:55]
If I select this, I can change it from the roof layer, which is currently wire frame to the beam layer. And
now we can see what's going on there. Now I'll just select these two rafters and drag a copy over. With
this new copy, if I go here and say, 'Create a tie beam', again we've got some information here. It now
will create a different type of structure. Let's go to 3D. These go on the sides, the tie beam element
here, I’ll again put it onto the beam layer and it goes underneath it. You may notice the gap here; this is
because we have not put the beam across the top there. So those are all the individual pieces here that
we can do. [0:24:01]
Now let me show you how it all works as a whole if we use the roof wizard. So I'm going to select all of
the objects here, go to the object tool and press Command+A or Ctrl+A which selects all objects. I'll
delete them. Now I will select this roof and use the roof wizard. The roof would wizard is available here
and it's also available under Roof Extras, Roofmaker, Roof Wizard. All of these commands are. It then
says 'Tell me how you want rafters, collars and ties, beams, blocking, hip rafters, all of these things. And
I'm just going to leave it in the default settings, although I will put them onto the beam layer so they will
look solid. [0:24:47]
And you can choose with collars and ties do I want them to be tie beams or collar beams, all of these
settings here. Each one of these has a layer. This layer is for the entire setup. So let's see what happens
when I say OK. Let's take a more complex roof system and do something slightly more complicated to
show how that works. So if I take the wall tool, there's a shape that is certainly more complicated. Let
Best Practices Course – Week 17 Part 7 – © copyright 2014 by Eric Bobrow

me go to the roof tool and say I'd like to draw a multi-plane roof with hips wherever it needs to be. I will
magic wand this, and you can see how it instantly does that. And let's just go here and make this a gable
roof at this end as opposed to a hip. So before ArchiCAD 15, you would delete this piece and extend the
two opposing roofs to make the gable. In ArchiCAD 15, we press down on the edge of the reference line
here and use the pet palette to say I'd like to make this edge custom. And I'd say 'I'd like to make it a
gable', and say OK. [0:26:50]
You can see how it stretches out. So that's different. In ArchiCAD 14 and earlier, you would delete that
piece and extend this line. Let's take a look in 3D here. It looks like I would make this a height of 10 feet
rather than 9 feet, so it sits nicely on top of the walls here. Now let's go do a roof system. I will select
this and tell it to do a roof system here. I will leave the settings at the default and say OK. It's going to
think about it for 10 seconds. There it is. So that shows you the potential power of this element. So let's
look at some of the changes that we can do after the fact in terms of the way the Roofmaker works with
the roofs. [0:28:04]
So if I go to the layer dialog and make roofs solid, we're going to see what's going on with the roof
elements. You will notice that the framing is right at the bottom; it's meeting that edge there. You can
see it's sticking up through there. If we can choose some things with the way that the bottom edge of
the roof would be. If we have a horizontal soffit here or not, what's going on inside the building, is there
going to be a ceiling and all of those sorts of questions. Let's take a look in a section here. I'll do a
section marker. Let's just do it in line with this rafter here and open the section. We'll see how this
structure is set up. [0:29:29]
Now what is the thickness of this relative to the roof? It actually did not automatically match the rafter
to the structure of the roof. It just lined it up at the bottom of that. So that's one thing to know is that it
will use the bottom plane of the roof as the reference for its construction. The individual elements, if I
select this, I can drag this up in space. You can see what that did. I can drag it up to this point. So I can
modify it after the fact. That was an individual element. If I want to move the whole system up to fit
better, then I would want to select them all at the same time. So let me just undo that there. So how
would I do that? [0:30:19]
If I was in 3D I could go to the object tool and select all objects. I could be more specific if I had other
objects already placed, I could go find and select and select. I eyedrop one of these guys here. And it
says it's an object, and I might want to say objects are on a certain layer, so that they are on this layer. I
might also be more specific to make sure I'm selecting all of them. Now if groups are not suspended,
then all of these elements, which were created in a single process, are grouped. So I can select one and
it selects the entire system. Then I can drag them up. I will say drag this point up to here, and can see
that actually just moved everything up there. [0:31:16]
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So you can adjust the things after the fact if you make a mistake or change your mind or the design
changes. We can also go and suspend this. Let's be more specific. I will select these guys here. I want to
pick up the settings of this particular selected element and add in the fact that the name of it is "Rafter".
And say 'Select all of these rafters'. This is one hundred and thirty seven elements; it does not include
the upper elements of the beams and things. But let's just say that we decided that these should be an
eye beam instead of the dimension here. Say OK and you can see how they have all changed to that I
beam shape. [0:32:17]
We can also change their dimension and more. I am going to undo that to keep it simple. What other
changes can we do? We'll take the connecting beam there and maybe they're positioned in a way you
don't like. This is sitting outside the building and it was a nice two foot distance from here, rather close. I
can just drag these over. I can measure that and basically position it where I want. Maybe because it's
outside the building I don't need those. Let's look in 3D. That actually removed one of those members
there. Maybe we don't need this one going across the face there. Things like that. All of these are
independent that we can work with. [0:33:20]
Now, in terms of graphic appearance, if I select a couple of elements to demonstrate and open this up, I
could choose the 2D attributes here. Do I want the rafter visible in 2D? What does that mean? Do I want
the body of the rafter to show? If I turn this off, it is only going to show the axis line. Now we are getting
just the axis line. So it's up to you if you want to show it in a more realistic way or in simple line work.
That would be true for many of these elements here. You have the choice of showing just the axis line or
the full body. Now if you did decide that you wanted this roof to have a different setting, perhaps I
wanted the offset to be 18 inches. So now that roof is coming in. And let's look in 3D, and we're going to
see we have a problem there. [0:34:23]
Because we just put in a system and we hardly have customized it, it would be best to just delete it and
do it again. ArchiCAD would make these fit. But sometimes you have done substantial work, so how
would you deal with that? Let me select a few of these elements and take these ones I have selected
and open them up. And one of the options is an overhang. So if I say 18 inches, you see how they
automatically shorten. They still kept the end condition here, but they have a different extension. Each
one of these, if I select it, I can go and use the edit a single point. It depends on which one I get. This one
would change the width. That would be very wide. This one here would change the overhang. So I can
type 1 foot, and you can see how it's basically changing the distance from here to there. [0:35:29]
So you can do that numerically in the dialog box or by grabbing that point, and you can literally stretch
this into position. So there are a lot of controls for fine tuning. So if you find that you need to change
something about the roof on one side, you can adjust that. If you need some extra reinforcement in a
certain area or maybe you going to put in a gap around a skylight or things like that, there are some
other options there. So say we wanted to put a skylight in this area. That would be an interesting
instance. If I go to the skylight tool and pick a skylight dome, that's fine right now. If I click, it basically
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has put in this element. Also like the rafters or the roof framing, that element is automatically picking up
the slope of the roof. I did have to tell the height of the roof or the angle of the roof. If I move this and
drag this around, it's going to find its new position. I will drag it down a little bit. You can see how it
automatically moves up or down, because it knows as I move it around in its plan position; it's going to
find the place in the roof geometry. [0:36:56]
And it actually cuts a hole in the roof. If I select the roof element, it's not showing the hole, but it is
there. Let me move this up a little bit higher. I will just drag this here. Now I don't know how roofs are
built, but I'm going to do a quick sketch to show you what some of the options are. If I select this and
delete those elements, then select this and pull this down, this is the structural length of the span. If I
pull this down short, now let's take a look in 3D. You can see that the one I did not move has been left in
place. The other one is now clear. And this one here is short. We can pull it to the appropriate position
that we might need to. We can put some blocking across there and other stuff. [0:38:06]
If we look at a section through that, let's see here… I didn't quite extend it out. No, actually I did extend
it out beyond the roof line. So let's open the section here. So you can see how what's going on there. If I
select this skylight, you can see how it's framed perpendicular to the roof, which may be just fine. There
are probably some options here for the line and edge angle, a perpendicular head and sill. So let's just
say that I want this to be horizontal. What would that do? So that's probably not what we'd want. But
let's undo that. So there are some options in terms of the skylight that will affect this. But basically we
can make the framing fit around anything that we need. [0:39:17]
Let's take this up. It looks like we don't have a snap point for this. There is one. I am not sure if that is
the right one for this. Let's say we did that and I took this and stretched it down to the same point and
we put in blocking. So I select these two and go in and say create blocking. And it says, 'What is the
dimension of it?' and, 'Click position of blocking between the rafters.' Let me put this in next to it and
look in 3D. I will go and make the roof element again. I will go to the roof element and make the layers
transparent wire frame here. And now you can see what is going on there. So as I said, I am not sure
how this would be built, but I think you can gather that you can create this system using these elements
pretty flexibly. [0:40:35]
So let's see if there are some questions, because I ran very quickly through the basics. Maybe there are
some clarifications that I need to look at. So Scott Newland wrote a while ago, "I don't understand the
difference between the beam and the plate beam." Okay, that is a good question and frankly, I don't
know the difference between these elements in actual practice. I am going to pull up the reference
manual and we'll take a quick look. Tracey D'Alessio says, "How would you change the original roof to be
3/4 plywood that is laid on top of the rafters?" Okay. And, "How would we create ceiling joists below the
rafters?" [0:41:17]
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Bob G. says, "Can the collar ties be shown on only one side of the rafter pairs and spaced at alternating
rafter pairs?" Okay. There are a lot of different questions. Ken Andrews asked, "Can you use Roofmaker
for floor framing plan?" Iain Dykes says, "Can you alter the pitch of a framing system?" All of those are
excellent questions. [0:41:56]
Now if we were to take the roof and change the pitch, right now we are at 6 and 12, let's make it 8 and
12 here. I am going to keep the custom plane. That means that the gable end will stay custom.
Otherwise I could put it back to being a hip on all sides, but here I will keep the gable. Right now this is
set at a slope in 12 inches, so I need to type 8 inches rather than 8 feet and 12. So that would be 8 and
12. Say OK. And you can see the roofs are collared. So if we change our mind on it, what would we do? If
I select these elements here - and I can select all of the related rafters - I could go in and change them
from a slope here. This slope, 26.57˚, what is that slope? [0:43:06]
Unfortunately, I can't read off the 8 and 12, so let me go and say this system here is, in terms of degrees,
33.69˚. So if I take these guys here as an example and make them 33.69˚, now let's look at that more
closely. It looks like its parallel. I guess I changed the roof and made is so that this was only 18 inches,
that's why these two are sticking out. Let's see how we would change this. Maybe I want it to stick out
two feet on this end. So I will go to this edge and go to the settings saying this has some unique settings
for this edge. So this custom plane is a gable. And here's where it was two feet. I will put it back to two
feet here. [0:44:07]
And you can see now it extends out. So if you change the pitch, you could select all the rafters and
change them to the new pitch, and then select all of the other elements and move them around. Given
how much work that would be, it might be better to start the system over. In other words, delete those
elements and select the roof and create a new set. It would depend on how much detail there is and if
you had done modifications. If you place them in and tweak a few things, then start over. If you have
done a lot of tweaking then it could be worth doing it manually. So that's an answer to Iain Dykes.
Hopefully that answers that. [0:44:56]
Now Ken Andrews says, "Could you use Roofmaker for floor framing plans?" So if we go to the floor plan
here, Roofmaker only does framing for roofs. But, let's say that I wanted to do a slab. Let me put in some
walls to the side. This is an interesting question here. I am going to create something, because I have
seen this question come up, and I think I can demonstrate at least one part of the answer. If we had a
slab that was - I am just going to use the magic wand to put it in on the inside. So here, if I look at this,
and we say, 'Show me just what's in this area.' So that is now a floor under the walls, at least the basic
concept. [0:46:01]
Now instead of having a floor, I delete this slab, and I put in a roof. In this case I am going to do a single
plane roof. So the single plane roof means that there is only one plane. I am going to make this at a zero
degree slope. Interesting that it actually defaults to zero. Let's put this up at zero height, and we can
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move it down because it would have to be below. It says, 'Enter first note of roof pivot line.' So I have to
actually pick a pivot line here. Say it's going up this way, but it's actually not going up this way. It's going
to be zero degrees. And then I will magic wand the outline here. Now you can see there is a roof
element here. If I look in 3D, that roof element is in wire frame. So let's just put that layer back to where
we can see it. [0:47:04]
Actually, let's put it back so it's here. So that roof does exist here. It's just a wire frame right now. Having
done that, I will select the roof and tell it that I want it to do multiple rafters. Let's make the distance 16
inches. I will go then from this point to that point. You can see how it has created a bunch of elements
based on the criteria that I set. If we look in 3D we can see what it's done. To some extent, you could use
this as a quick way to create some type of framing. You obviously would want to set it to the dimensions
that would be appropriate. It will automatically trim it within the boundaries of the roof. You could leave
this element as a roof, or you could hide that element and put in a slab if you preferred. [0:48:25]
In terms of ArchiCAD 17, the intersections of walls and floor slabs will automatically be calculated based
on the building materials. So you can have the core of the walls sitting on the core of the floor, but the
cladding wrap around it. So those are some options that work with slabs and walls automatically. You
can get the same effect between a roof and a wall, or walls, by using the merge elements command.
That is something I have demonstrated in other trainings, but I will say 'Show All in 3D'. Why are we not
seeing - I will say 'Show All in 3D' here. There we go. That command that I am mentioning is if you select
the roof or one or more walls, there is an option under Connect to merge the element. [0:49:33]
And this would be necessary if you wanted the walls and the roofs to clean up properly in ArchiCAD 17
using the building material priorities. So that is something that is important if you want to have that type
of cleanup. So let's see, Ken Andrews writes, "Thanks, that works." Okay, good. So I have answered
those two. Let's go back to Bob George's question, "Can the collar ties be shown on only one side of the
rafter pairs and spaced at alternating rafter pairs?" So let's go back to the floor plan here. So this is an
object you can see is a collar beam. There is an option here for collar tie double right or left. So I could
say right, and you can see how it switches. So when you choose, there is an option for one side or both. I
imagine if you chose one side, we can certainly delete these alternate ones. [0:50:40]
You were taking about having them every other. Then we could take these guys and go in and say I want
it to be on the right side and now you have that there. So let's see if that works for you Bob George.
Okay and Albert V. writes, "I know this is not part of the presentation, but is there a tool that will do wall
framing with the same ease?" The short answer is, there is a goodie that Graphisoft provides that will do
some basic wall framing. It has some power but also some limitations. There is also a more robust tool
that you can buy from Cadimage. I am not sure; they have recently discontinued some tools that
probably weren't selling so well. I am not sure if this is one of those that is discontinued or if it still
exists, but they do have a framing tool that was much more robust and sophisticated than Graphisoft's.
[0:51:40]
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So that I can show in a coaching call or perhaps have a separate lesson on that. Moving backwards, Dave
Norman says, "How can we create ceiling joists below the rafters?" Okay. So in terms of the joists here,
let's go back to that diagram here. There are some options in the roof wizard to create posts and
supports, but there wouldn't be an option to create a ceiling joist within the roof wizard. So what we
need to do is create the joist by using either beams or objects and manually repeating them. So I will go
back to ArchiCAD here and let's just put in a slab up at ceiling level. I am going to put this up on the
ceiling layer here. I am going to do something simple to represent the ceiling. [0:52:59]
Let's say it's going to be some gypsum for the ceiling. Where's the gypsum board? Let's say that it's up
at 9 feet. And it's going just to 8 foot 11, so it's going to be 1 inch, maybe 5/8 inch or something like that.
Let's go in and perhaps these walls - I'm going to temporarily hide the roof information. One of my
favorite palettes - if you're not using it, I recommend highly that you get used to it - is the quick layers
palette under Window, Palettes, Quick Layers. And I can then say select one of these elements and hide
the layer that it's on. But then I can undo it and put it back. Or redo here. So now I can go and put in this
ceiling. Let me magic wand here. Using the magic wand it created a slab element. If I go to 3D, we're
going to see that we have the roof up here and we have this little slab representing the drywall.
[0:54:20]
So we put some framing across, and let's not worry too much about the wall plates and things like that.
Let's just put some framing just to get the basic idea. If you were to do that we could use the beam tool
specify it to go from 9 feet to 10 feet. I will just leave that alone. And how thick are they, well I don't
think 8 inches is necessary, but let's just do 5 1/2, something like that. Horizontal, I'll just go on the
beam layer, let's choose a layer. So really it normally would be on that layer, but let's put it on a
different layer here. Just put it on the ceiling layer and go across to here. If I multiply this every 16
inches or something like that and take this across partway, I can easily go…here is a nice little thing.
[0:55:24]
If I select these guys and tell them to extend using this adjust command, and I click on the edge of this
wall, only the ones that are in this area will extend. I just extended them to the face of the wall. Let's
just say undo. Can I extend them to the face of framing? Yes I can. So I went to the edge. And by the
way, in ArchiCAD 17, you do have sensitivity to the face of framing here or an interior wall skin. I'm not
sure if that was available in 16. Certainly it wasn't available before. Before, what you could've done is
selected extend, and then instead of going to the edge, because it would be a stripe here, you can go to
the corner where you would have a snap and draw a line. If you to draw a line, be aware that the length
of this line is going to be important because when I click here, only the ones that are in that line will be
extended. [0:56:27]
So if I wanted to make this all of the edge here, let me just actually go and multiply this all the way
across to show. This is really quite cool if you haven't experimented with this. This is really a nice thing.
I'm just going to drag this one over. I'm not sure exactly how it will fit in with the walls here, but let me
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just start it a little bit over there. Now I will do the multiply at the spacing and take it all the way across
to here. And then with all of these selected, I'll say adjust them to this edge. Only the ones in that area
will adjust. Adjust to this edge, and the only ones in that area will adjust. And in fact these guys over
here, I want to pull them back. So I will adjust them to this edge here. And you can see how that works.
So you can very quickly go and do framing like this. I think you get the idea of how powerful this is to be
able to adjust that. [0:57:42]
So now I have all this framing here. If I look in 3D you'll see that. If these elements are too big I can
select them and make them a little narrower, and what material they are. Let's see if that…Tracey
D'Alessio writes, "Ceiling joists can be made with the collar tie option if you know what height to set
them at." You can do that, yes that is true. Dave Norman says, "For ceiling joists can we add a second
set of rafters set at a 0 to 12 slope?" That's a good question. Could we add a second set of rafters? So
we have two interesting suggestions, one from Tracy about collar tie and the other by Dave Norman for
a second set of rafters. So let me undo back and get rid of these guys here. Actually I'll keep them and
put them on a layer that is hidden. [0:58:56]
So I'll change them from the ceiling layer to temporarily I'll put them into the demo layer. So they will
just disappear for now. We could bring them up if we wanted. So the roof has a system created by
Roofmaker. But we could go in and say that we'd like to create collar beams. Collar beams - you have to
select the two rafters first. So actually we may not be able to do that. Let's just see if we use the roof
wizard and say do not create rafters, do not create these beams or blocking, or the hip, because we
already have them but we want to go to the collars and ties. Notice this is not available because the
rafters, we are creating rafters. If I said 'Create rafters', then we could create that. So that would be a
limitation there. [1:00:01]
We can't do it on mass that way unless we think about this at the time we are creating it. But what we
could do I guess is if we go back to the layers, and let's undo this layer. So we can see these layers here.
Let's select these two elements here and say that we want to create a collar beam. And set its height at
10 feet, something like that. What does that do? Single sided here, OK. And it says 'Click for collar beam
side.' So if I click on the side, did it do that? Let's look in 3D. I don't see that it created a member across.
So did I do something? Maybe one of you has a little tip there. [1:01:09]
I'm not quite sure whether you can do that or if it works. Select these two and say I'd like to do a plate
beam, a collar beam or tie beam. So tie beam would be going across the bottom, underneath them. So
let's just say 10 feet here. That did go underneath, I saw something come up. So now if I look in 3D we
can see that this element came across. So it would be at least one possibility to use the tie beam to go
across there at a height. And that was at 10 feet. Let's just undo that and do that again with a 9 foot
height. Let's go to the tie beam at 9 feet, let's see if that'll work. If I look in 3D, no, it did not. Maybe
because it's below the height of the roof. The roof starts at 10 feet, so it won't go down below that I'm
guessing. [1:02:17]
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So anyway, you can experiment with it. Maybe you would be able to get it to work. And let's see - plate
beams should be at the top of the wall. So John Gilchrist that's a good point. Ken Andrews, "If you do
another roof like you did for the floor framing on the right and then do as ceiling rafters." It is possible,
remember that this roof is - although it was used as the geometry initially it is independent. In fact w
could delete the roof and the framing would still sit there. We could create another roof and put
different roofs on different layers. There are ways that you can use this to create a bunch of framing and
manipulate it. [1:03:07]
Now that brings up the question, let's just put this back to the original slope which 6 and 12 here. And
we'll again put these guys back to the slope there - I have to read off the slope - 26.57. So what were we
doing? Oh, the thickness of the roofs and putting stuff on top of it. So one possibility that you may want
to do and this is an interesting thing I have not experimented with too much, but let's just say if I took
this roof and I told it to have an overhang of zero. Maybe we'll just change this to a single type of roof
that is wood framing. I'm not sure this is 6 and 12. Here's the thickness with a birds eye cutout of it.
Let's just try that and see what it does. Now how thick is that? Actually, let's go through the section
here. So now you can see the roof is simpler there. [1:04:44]
And what is the cross sectional thickness of this particular framing? So obviously, you would probably
want to specify that it's 2x6, 2x8, 2x10, whatever the dimension is. But if I just want to take these and
use the default thickness and then make the roof the same thickness, I can measure that. I'll just go to
the measure tool from here and make sure that I have the perpendicular snap. It says its 3 1/2 inches
going across there. So let me change the roof to 3 1/2 cross sectionally, 3 1/2. And you can see now it's
exactly coincident with that framing. And why would I do that here? If I put the roof layer back to being
like this, I now have the roof solid body here, and these stick out as rafter tails. Now I am going to put
another copy of this roof above it. [1:05:51]
Forget about the skylight, because that might introduce complications. But let's say if I put another piece
above it that actually is the cladding, the plywood and asphalt or tiles or something like that. So how
would I do that? If I go to this roof, it actually is now coincident with the walls. So now I have the roof
selected here. I'm going to drag a copy. And this copy I'm going to leave it exactly in place. But this new
copy I just dragged right in place. I'm going to go in and say I'm going to make it out of an exterior
material right now. And make it just for initial things I will make it 2 inches thick. And I'm going to raise it
up by a certain distance. So in other words its base isn't going to be 10 feet. It's going to be 10 foot 6
inches. [1:07:04]
I also wanted that one to extend out to two feet. So if I go to 3D I've now got two roof systems. Let's go
underneath it and we can see it better. We've got this under roof system and we've got this upper roof
system. And let's go into that section here. And I wasn't sure of the height. Now I can just drag this
because remember this is one entire roof system. So I can literally just drag this on top of that, and now
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it's going to line up nicely. Let's look in 3D, and you can see that we now have this overhang here with
just the top cladding whatever thickness we want to represent this. [1:08:05]
But in a section, we've got the roof thickness here. So in fact what we're seeing is the rafter tail sticking
out. And if we wanted to look at a pure section, we go to section settings and there's an option that you
may not be aware of. That is under sections we can choose the horizontal range to be infinite, limited or
zero depth. That basically means cut through this and do not show anything beyond it. And you can see
now we're seeing as we cut through this, here is one roof system and here is the other roof system.
There are two separate roofs. And obviously we would want to make it the right thickness. We would
want to have it representing the proper surface with tiles or asphalt or something else. But this would
be a very quick way to generate that. [1:09:07]
Let's see if we have some questions. Carol Wiley says, "Does ArchiCAD have a way to create scissor
trusses?" So we looked a little bit at trusses. Actually we had a whole lesson on Trussmaker last week. In
the object tool, if you look in truss, you'll see there are various types of trusses including a scissor truss
here, and this has various options for the dimensions here and how many divisions and things like that.
If I take it in four divisions it will be a little similar. Six, let's see eight, or ten; it's going to recreate that. It
depends upon the length. If I take this to a shorter length it's going to look rather odd here because it's
also saying how high is it rising up. So if I changed that to a smaller rise, this is what it does. So there all
sorts of truss structures in here as well as the Trussmaker training that I gave last week. [1:10:21]
It's in the member area in this same section, week 17. You can either use one of their automatic ones
here or you can use Trussmaker to build it manually. Ken Andrews says, "This is by far the best lesson
you have done, this was something I've struggled with." Thank you so much Ken. You have been on all
the lessons and lots of coaching calls, I'm very pleased. Carol says, "Thanks." Okay so I've answered a lot
of questions. Let's see Iain asked, "Can you delete the roof element after placing the framing?" The
answer is yes. You can do whatever you want with it. The roof element is the guide for creating the
geometry, but then you can modify or delete it afterward. Dave Norman asked way back half an hour
ago, "Could we create ceiling joists?" We've already looked at that. [1:11:23]
Tracey said, "How would you change the original roof to be 3/4 plywood that is laid on top of the
rafters?" I think I did that. I didn't do ¾. But let's just select this and we could make this instead of 2
inches, we’ll say ¾. And we could say it's not generic, this is plywood. And now we've got something like
that. And of course we could have yet another roof element or something for what's on top of the
plywood. Tracey, let me know that answers that question. Scott Newland had asked about the
difference between the beam and the plate beam, and then I had the comment from John Gilchrist
saying, "The plate beam should be the top of the wall." So let's just take a quick look at the
documentation here. [1:12:16]
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So if we look in this, we have collar beams, tie beams. Let's just click on this. 'To place a collar beam,
you must first select two rafters. Place it between to create a tie beam. You must select two rafters to
place in between.' Now this is a pretty quick little section in the reference manual. And if you know how
you want the roof to be constructed in the real world, this will at least explain how you do that. So
hopefully you've got enough there to answer those questions. Chris Sinkinson asks, "Can you cut the
rafters and also can you use a custom profile for the roof?" And Ken Andrews asked, "Using
MasterTemplate and your layer combinations, this would work great with the framing portion of
documents." OK interesting. Definitely framing. [1:13:34]
Obviously here we are creating framing in 3D. And it has options for plan representations showing axis
lines or the body. So yes, you can create your flaming plan there, whether you are using
MasterTemplate or other things. We do have in MasterTemplate some more dedicated layers for
structural and framing plans than might be in the basic Graphisoft templates. Chris says, "Can you use a
custom profile for the roof?" I'm not sure what you mean by a custom profile for the roof. You can use
a custom composite, but a profile would be a little different here. Chris also says, "Can you cut the
rafters?" I believe I ready demonstrated that. [1:14:24]
If I go back to the floor plan, this rafter here originally extended all the way up and I shortened it. If you
want to cut a rafter, let me demonstrate this. What I might do if you want to have it start and stop for
some reason, then what I could do is drag a copy of this. I'm going to drag a copy over, so now I have
two of them. Now in this one, I will shorten it and snap it to that. And this one I will actually tell it to
have a zero extension here. And what if I were to shorten this? What I want to do is see if I can end with
the top part there. If I pull this back, no, that's the profile width. I have to zoom in on this and make
sure I am in the center of it. And structural length, and let's take this up here. Then I will move this in
line. [1:15:41]
So if I take a look at just these two elements in 3D and show just the selection in 3D, that did not
instantly work because the height of this element and the height of that element are the same. Basically
I essentially moved the starting point there. But if I were to show all in 3D, I could select this and drag it
up or I could do it in selection assuming that my section - if I go to that section and say don't just show a
zero section, show the horizontal range extending. And now we should have that little piece. So
essentially what I could do is duplicate this and then drag this up into position. It just disappeared
within here. I want to make sure the height is the same, maybe cut a section through it. So I'm not
sure, hopefully that answers your question Chris. [1:16:40]
Chris says, "Yes, but can you cut rather than stretch?" Possibly with objective. Objective is a great tool
that was originally created by Ralph Wessel with his own company in the U.K. called Encina. He sold the
company last year to Cadimage, so now it's available through Cadimage. I believe he still involved in the
development. Objective is a great tool for doing somewhat more free form modeling or more complex
modeling than you have built into ArchiCAD. And one of its cool things is that you can take any object
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and literally cut the object. I can't remember exactly how it's done but it is an add-on to ArchiCAD that
increases some of the geometric possibilities. [1:17:30]
You can do that, but in fact, if you wanted to cut that rafter, what I might do is use the solid element
operations. In other words, create something that is the void that you want to remove from the rafter,
put it on a hidden layer, and just subtract it from the rafter. But you cannot cut the rafter just with the
basic one, you would have to stretch it essentially and move into position. So I think we've gone an hour
and twenty minutes. Let's see if there are any final questions. Chris says, "Cheers." So I guess I at least
answered it as well as can be expected right now. So I'm interested in your feedback on this lesson. I
really appreciate that Ken Andrews gave me such a nice complement about this being a great lesson.
[1:18:30]
You know what's funny is I haven't worked with Roofmaker very much and so I'm not an expert. Most
people haven't asked me about it; it hasn't been widely used, perhaps because it's less well known.
Sometimes I think once you see it demonstrated, and you see some of the manipulations that are
possible, you realize that there are some powerful tools that could be greatly beneficial. I'm glad to put
that in front of you, because that's one of those hidden gems that perhaps will make your life easier.
Allow you to create not only framing plans but 3D models that are more detailed. Perhaps there are
going to be conditions were the roof framing is exposed, and this will be really part of your design or
your design presentations. [1:19:31]
I think Graphisoft has a lot packed into ArchiCAD that many users just have never been comfortable
exploring. They're too busy getting deadlines done. So Roofmaker clearly is one of those ones that you
could take advantage of in many cases. So let's see if there's any more, Ken Andrews writes, "Huge time
saver." Chris Sinkinson writes, "I will use it more often now." Don Schlining says, "Can skylights be placed
in the roof element before placing framing members?" We'll just finish up with that and do a quick test.
What happens if we place the skylight in here? So let's go to 3D here. Let's place a roof on this other
one. Then do the Roofmaker. So I'll go to the roof tool, say I want to create a roof system, magic wand
this. [1:20:33]
So you can see how we can do that and 3D. Not everyone knows you can magic wand in 3D with
elements like the roof tool; that will trace that. Let's go back now to the floor plan. You'll remember
these elements here were for the floor framing. Let me hide that layer here. And let's go now to put in
the skylight, so we'll do a skylight and we'll pop it in here. Let's verify that it looks okay. Looks fine.
Select the roof and go to Roofmaker. We'll put it on some other layer, not the hidden layer. Put it on
the roof layer directly. And we will tell the Roofmaker to do its job, go ahead and create all of these
things, say OK. And look at that. It actually framed around the skylight. Impressive. [1:21:47]
Let's take a look in 3D. See you can see that there is nothing in the middle of the skylight. If I go to that
layer and make the roof layer wire frame, there it is. These guys are cut off neatly to fit around that.
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Great question Don. Thank you all for joining me today and giving me the great questions that help to
fill out this lesson. Please add any follow-up comments or questions on the page down below the
recording that we have in the members area. This has been Eric Bobrow, thanks for watching.
[END OF AUDIO 1:22:41]
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